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Important Announcement 
 
The information contained in this document is the property of Atop technologies, Inc., and is supplied for the sole 
purpose of operation and maintenance of Atop Technologies, Inc., products.  
No part of this publication is to be used for any other purposes, and it is not to be reproduced, copied, disclosed, 
transmitted, stored in a retrieval system, or translated into any human or computer language, in any form, by any 
means, in whole or in part, without the prior explicit written consent of Atop Technologies, Inc.,  
Offenders will be held liable for damages and prosecution.  
All rights, including rights created by patent grant or registration of a utility model or design, are reserved. 
 

Disclaimer 
 
We have checked the contents of this manual for agreement with the hardware and the software described. Since 
deviations cannot be precluded entirely, we cannot guarantee full agreement. However, the data in this manual is 
reviewed regularly and any necessary corrections will be included in subsequent editions.  
Suggestions for improvement are welcome.  
All other product’s names referenced herein are registered trademarks of their respective companies. 
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1 Introduction 

Thank you for Buying Atop’s Protocol Gateway.  
 
The product is bundled with the following three user manuals: 
 

1) Hardware specific installation user manual, not covered in this document. It covers Atop’s hardware 
installation procedure, wiring, power connection etc. 

2) Getting started with Atop’s Protocol Gateway: Basic Gateway configuration, Gateway architectural 

overview and eNode Designer general instructions– this manual. This manual covers the installation, 
network configuration, maintenance and using of the configuration tool software, including the procedure 
to be followed for uploading new configurations to Atop’s device. 

3) Protocol specific user manual, not covered in this document. Such manual covers: 
a. Step-by-step protocol set-up between Client/Master – Server/Slave of the Protocols in eNode 

designer 
b. Description of the protocol-specific software features (of both protocols), the device profile and 

the implementation table of supported functionalities. 
 
 
 

1.1 Scope 

This document is divided into 2 major sections: 

 Getting started 

 Basic Network Settings with WebGUI  

 General Description : it explains the general Gateway architecture and the goals of eNode Designer and 

its working principals. 

 eNode designer User Guide : it walks the user through all features of the eNode Designer, specifically 
explains how to add, delete, and edit projects and carry out device configurations. 

 
 

1.2 Overview 

 

1.2.1 List of Abbreviations 

 
AAP  = Alarm Annunciator Panel 
ADH  = Application Data Hub 
CFE  = Communication Front End 
EDM  = eNode Designer Module 
FTP  = File Transfer Protocol 
PDF  = Portable Document Format 
RAM  = Random Access Memory 
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2 Getting Started 

 

2.1 Packing List 

 
Inside the purchased package, you will find the following items.  
 

Table 2-1 Packing List 
Item Quantity Description 

PG59XX Series 1 Protocol Gateway 

Mounting Kit 1 

PG5901, PG5904D, PG5901B and PG5901E 

 DIN-Rail Kit (x 1)  or 
 

PG5908, PG5916, PG5900A, PG5908A, PG5916A Series 

 Rack Mounting Type-L angles (x 2) 
 Screws (x 6) 

Terminal block  

PG5904D and PG5904D-Sis 

 7-pin, 2ESDVM-07P (x 1) 
 5-pin, EC381VM-05P (x 4) for PG5904D-Sis-X only 
 

PG5901, PG5908, and PG5916 Series 

 3-pin, 2ESDV-03P (x 1) 
 

Documentation 1 Hardware Installation Guide (Warranty card is included) 

 

Note:  
 Notify your sales representative immediately if any of the above items is missing or damaged upon delivery.  
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2.2 How to order 

 
Please refer to the following product codes to place an order. 
 
Table 2-2 Product Codes 
 

Item Description 

PG5901-X 
1-Port Serial-to-Ethernet Protocol Gateway, Dual LAN, RS-232/422/485 
software selectable, DIN-Rail type 

PG5901B-X 
1-Port Cellular to Ethernet and Cellular to Serial Protocol Gateway, 
LAN, one RS-232/422/485 software selectable, DIN-Rail type 

PG5901E-X 
1-Port Serial-to-Ethernet Protocol Gateway with one Profibus port, Dual 
LAN, RS-232/422/485 software selectable, DIN-Rail type 

PG5904D-X 
4-Port Serial-to-Ethernet Protocol Gateway, Dual LAN, RS-232/422/485 
software selectable, DIN-Rail type 

PG5908-X (US) 
8-Port Serial-to-Ethernet Protocol Gateway with RJ45 connectors, AC 
100-240V, US power plug 

PG5908-X (EU) 
8-Port Serial-to-Ethernet Protocol Gateway with RJ45 connectors, AC 
100-240V, EU power plug 

PG5916-X (US) 
16-Port Serial-to-Ethernet Protocol Gateway with RJ45 connectors, AC 
100-240V, US power plug 

PG5916-X (EU) 
16-Port Serial-to-Ethernet Protocol Gateway with RJ45 connectors, AC 
100-240V, EU power plug 

PG5900A-X 
Ethernet-to-Ethernet Protocol Gateway, 6 RJ45 or SFP ports,  
IEC61850-3 certified hardware 

PG5908A-X 
8-Port Serial-to-Ethernet Protocol Gateway with DB9 or TB5 
connectors, 6 RJ45 or SFP ports, IEC61850-3 certified hardware 

PG5916A-X 
16-Port Serial-to-Ethernet Protocol Gateway with DB9 or TB5 
connectors, 6 RJ45 or SFP ports, IEC61850-3 certified hardware 
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2.3 First Time Installation 

 
Before installing the device, please follow strictly all safety procedures described in the hardware installation guide 
that is available inside the box or on Atop’s website. Atop will not be liable for any damages to property or personal 
injuries resulting from the installation or overall use of the device. Do not attempt to manipulate the product in any 
way if unsure of the steps described here. In such cases, please contact your dealer immediately. 
 
When the device is running, connect it to computer to carry on network configuration. Connect LAN1 port to a 
network switch or to your LAN with a UTP cable, and connect a host PC to your LAN with another UTP cable. 

 
After network configuration is complete, it is possible to carry on protocol-specific settings. Protocol specific 
configuration is made through eNode-Designer utility that is available for download online. 
 
For more information on how to install the device, please refer to the Hardware Installation Guide leaflet available 
in your package. 
 

 

2.4 Factory Default Settings 

 

Network Default Setting  
 
The device comes with one IP address specifically for redundant Ethernet interfaces. 
 
Table 2-3 Default Network Setting 
 

Interface Device IP Subnet mask Gateway IP 

LAN 1 10.0.50.100 255.255.0.0 10.0.0.254 

LAN 2 192.168.1.1 255.255.255.0 192.168.1.254 

LAN 3-4-5-6 (*) 

192.168.1.2 
192.168.1.3  
192.168.1.4 
192.168.1.5 

255.255.255.0 192.168.1.254 

 
Remarks: Default DNS 1 setting is 192.168.1.254 and DNS 2 setting is 0.0.0.0. LAN 3-4-5-6 are available on 
PG59XXA family only 
 

Other Default Settings 
 
Other default settings are shown in the following table:  
 
Table 2-4 Other Default Settings 
 

Parameter Default Values 

Security 

 User Name admin 

 Password default 

SNMP 

SysName of SNMP 0060E9-XXXXXX 

SysLocation of SNMP Location 

SysContact of SNMP Contact 
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SNMP Disable (Unchecked)  

Read Community Public  

Write Community Private  

SNMP Trap Server 0.0.0.0 

 

Note: press the “Reset” button on the front panel for 5 seconds (see Sec. 3.9), to restore the Protocol Gateway to 
the factory default settings. 
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3 Configuration and Setup 

 
It is strongly recommended for the user to set the Network Parameters through Device Management Utility© first. 
The device-specific configuration can be carried out via Atop’s user-friendly Web-Interface. 
 

3.1 Configuration of Network Parameters through Device View 

 
First, please install Atop’s configuration utility program called Device Management Utility that can be downloaded 

from our websites (www.atop.com.tw or www.atoponline.com). After running Device Management Utility, the 

devices that are is already connected to the same subnet of the PC in use will be shown automatically. Device 
Management Utility automatically detects the Protocol Gateway and lists it on Device Management Utility’s 
window.  
 
Alternatively, the Protocol Gateway does not show up or is powered on after the software started, please press 

“Rescan” icon. The list of devices currently connected to the network will be refreshed as shown below 
 

 

Figure 3-1 - List of Devices on Network in Device Management Utility 

Note: This figure is for illustration purpose only. Actual values/settings may vary between devices. 
 

 
In the event the Protocol Gateway device is not in the same subnet of the PC. Therefore, please use Atop’s utility 

to locate it in your virtual environment. To configure each device, click the selected device (default IP: 10.0.50.100) 

in the list of Device Management Utility, and click “Configuration  Network…” menu  (or press Ctrl+N) or click on 

the second icon called Network on the menu bar, and a pop-up window will appear as shown below.    
 

 
 

Figure 3-2 - Pull-down Menu of Configuration and Network 

http://www.atop.com.tw/
http://www.atoponline.com/
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Figure 3-3 - Pop-up Window of Network Setting 

 

 

 
Then, proceed then to change the IP address manually. The system will prompt for access credentials to authorize 
the changes. Please input the Username and Password. After confirmation, the device will be restarted with a beep. 
After restart, the device will beep twice indicating that the unit is running normally. At this moment the Protocol 

Gateway will be running on the new IP address. It will be listed automatically by Device View along with its old 

record or it can be found by clicking on the Rescan icon. 
 

 
 

Figure 3-4 - Authorization for Changes 
 
Please consult your system administrator if you do not know your network’s subnet mask and gateway address.  
 

Note: If your LAN address begins with 192.168.X.X, please use the LAN2 interface for configuration.  
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3.2 Configuration through Web Interface 

 
PG59XX Protocol Gateway device is equipped with a built-in web server feature. Thus, the device can be accessed 
with a web browser for configuration purposes simply by entering the device’s IP address (default IP address is 
10.0.50.100) in the URL field of your web browser. If the user needs to change the IP address in order to access the 
web-configuration, please go back to Sec. 3.1. The figure below illustrates the overview page of the web interface.  
 

 
Figure 3-5 - Overview web page of protocol gateway 

 
Figure below shows the expanded map of the configuration menu. 
 

 
Figure 3-6 - Extended menu view 

 
Configuring the device is user-friendly. Please go to its corresponding section for a detailed explanation. 
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3.3 LCM (Liquid Crystal Matrix) Configuration (PG5916 only) 

 
The device also has the option of a configuration without using any software by using its interactive console. This 
method is however very easy and immediate. Buttons and their functions are described next.  
 
Table 3-1 LCM Button’s Description   

  
Buttons Button Description 

Menu

 

<Menu> Open Main Menu or Return to the previous menu 

 

<Up> Scroll up   

 

<Down> Scroll down   

SEL

 

<SEL> Select  

 

Example 
 
To change the device’s IP address, follow the instruction below.  

 Press <Menu> to enter Main Menu  

 Press <Down> to scroll down to 2. Network Set  

 Press <SEL> to enter Network setting and then <Up>/<Down> to scroll up or down to LAN1  

 Press <SEL> to enter LAN1 and then <Down> to scroll down to 1. IP Config 

 Press <SEL> to enter LAN1 IP Config and then press <Down> to scroll down to 1. Static, finally press 

<SEL> to save the selection. 

 Press <SEL><Down> to enter 2. IP Address. Use <Up>/<Down> to increase or decrease the Digits of IP 
Address, press <Menu> to return to one level higher after completion. 

 To enter: 3. Net mask, use <Up>/<Down> to increase or decrease the digits of subnet mask and then 

<Menu> to return to one level higher after completion. 

 To enter: 4. Gateway, use <Up>/<Down> to increase the digits of default gateway and use <Menu> to 
return to one level higher after completion. 

 Press <SEL> to the end of the menu to return to one level higher and the device shall display System 

message “Save & Restart”. Push <SEL> to 2. Yes, and <SEL> again after completion. The device shall 
restart and the new settings will appear. 

 

The LCM command structure is summarized in Table 3-2. 
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Table 3-2 LCM Command Structure 
 

1st layer 2nd layer 3rd layer 4th layer Description  

1.Overview 

Model name   Display model name 

Kernel ver.   Display kernel version 

AP ver.   Display AP version 

LAN 1 
1.LAN status  Display status of LAN1 

2.MAC  Display MAC address of LAN1 

LAN 2 
1.LAN status  Display status of LAN2 

2.MAC  Display MAC address of LAN2 

2.Network set 

1.LAN 1 

1.IP config 
1.Static IP Display or change static IP 

2.DHCP Display dynamic IP or enable DHCP 

2.IP address  Display or change LAN1 IP  

3.Net mask  Display or change subnet mask 

4.Gateway  Display or change the Gateway IP 

2.DNS server1   Display or change 1st DNS IP address 

3.DNS server2   Display or change 2nd DNS IP address 

3.Server state 

1.Console 

1.Web console 
1.Disable Disable web console 

2.Enable Enable web console 

2.Telnet 
console 

1.Disable Disable telnet console 

2.Enable Enable telnet console 

2.Password 
protection 

1.LCM 
console 

1.No Disable LCM console password protection 

2.Yes Enable and change the password  

2.Reset button 
1.No Disable the reset button password protection 

2.Yes 
Enable and change the password on reset 
button 

3.Ping 
1.LAN 1  

Use "ping" command to check specific IP 
address for LAN1 

2.LAN 2  
Use "ping" command to check specific IP 
address for LAN2 

4.Restart 
1.No   Cancel restart command 

2.Yes   Restart immediately 

 

  



eNode Designer User Manual Configuration and 
Setup 

 

Page | 17 
 

3.4 Automatic IP Assignment configuration with DHCP 

 
A DHCP server can automatically assign addresses, Subnet Mask and Network Gateway to LAN1 or LAN2. You can 

simply flag “DHCP (Obtain an IP Automatically)” checkbox in the Network Setting dialog using Atop’s Device View 
utility and then restart it. Once restarted, the IP address(es) will be configured automatically. 
 
 

3.5 Web Overview 

 
In this section, current information on the device’s status and settings will be displayed. An example of PG5904D-
X’s overview page is shown below.  
 

 

Figure 3-7 – Overview Page 

 
In detail, the following information is given: 

 Model Name, as its name implies, shows the device’s model. 
 Device Information displays information on the Kernel version as well as the AP version of the device. 
 Network Information shows the network properties of the two LAN ports  
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3.6 Network Configuration 

 
In this section, IP address, Subnet Mask, Default (Network) Gateway, Domain Name System (DNS) and overall 

connectivity settings can be accessed as shown in Fig.3-8. If you flag the DHCP checkbox, then IP address, Subnet 
Mask, and Default (Network) Gateway will be assigned automatically.  
 
 

Note1: It is not necessary to connect both ports. The user can connect only one LAN port to the Protocol Gateway device and change the network 
settings. 

 
 

 

Figure 3-8 – Network configuration Page 

 
At the lower box in the above figure, the DNS Settings box is available. This will allow the user to set the IP addresses 
of Domain Name Server 1 (DNS 1) and Domain Name Server 2 (DNS 2). If the device is connected to the Internet 
and should connect to other servers over the Internet (such as Network Time Protocol (NTP) server), the user will 
need to configure the DNS server in order to be able to resolve the host name. Please consult the network 
administrator or internet service provider (ISP) to obtain local DNS’s IP addresses.  

 
 

After finishing the network settings configuration, click “Save & Apply” button to save all changes that have been 

made. A Save Successful message will appear and after five seconds the web browser will be redirected to the 
Overview page7. 
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Figure 3-9 – Save completed Page 

 

3.7 Advanced Settings 

 

3.7.1 SNMP Settings 

SNMP (Simple Network Management Protocol) Settings determine whether the device settings can be viewed with 

a standard SNMP software. By default, it is disabled. Figure below shows the SNMP Settings page. 

 
 System Name, which is by default, is the MAC address of the device. 
 System Location is the device’s physical location. 
 System Contact is the device administrator’s contact information. 
 
In order to make the information available for public viewing by an SNMP Read Community string (a user ID or 

password), simply flag the “Enable” checkbox and fill in “Public_viewers” or your desired password string (the 

default string is “public”) in the Read Community field. In order to allow a group of people called “Power_users” to 

change the information, enter “Power_users” or your desired password string (the default string is “private”) in the 

Write Community field.  
After SNMP Settings configuration is finished, click the Save & Apply button to save all changes that have been 
made. That configuration will take effect after a few seconds and the web browser will be redirected to the Overview 
page. 
 

 

Figure 3-10 – SNMP Settings 

 



eNode Designer User Manual Configuration and 
Setup 

 

Page | 20 
 

3.7.2 Time  

Date and time can be set manually or through Network Time Protocol (NTP) to automatically synchronize date and 

time of the Protocol Gateway with a Time Server. The figure below shows the Time setting page. The user can 

obtain the Current System Time by clicking on the Refresh button. Under the System Time Setting box, the user 

can set the Time Zone by selecting the proper time zone from the pull-down menu. Then, to enable automatic 

date/time update, flag the Obtain date/time automatically checkbox. If this is unchecked, please set the time 

manually in “Manual time settings” later explained.  
 

If NTP is enabled, fill in the IP address or hostname of the preferred time server such as pool.ntp.org which is the 
default setting. If a hostname is entered, the DNS server should be configured properly following the procedure 

explained in Sec.3.6. Other options will hidden if the NTP option is selected.     
 

 
 

Figure 3-11 – Time settings Page 
 

If the Manual option is selected, select the current Date (Year, Month, Day) and Time (Hour, Minute, and Second) 
from their corresponding pull-down menus under the Manual Setting box. In certain region, the daylight time saving 

is practiced. In order to enable it, flag the Enable Daylight Saving Time checkbox and specify the Start Date, End 
Date, and Offset in the fields under Daylight Save Setting box as shown in the grayed out area of Fig.3-42. 

After Time Setting is complete, click Save Configuration to save all changes that have been done. A Save 
Successful message will show, and the web browser will be redirected to the Overview page.     
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3.7.3 Security 

The default security setting for the password is a standard password (default). To change security, enter a 

password in the Change Password box. The user should enter the Old Password (enter nothing in case of a null 

password), the New Password, and the Verified Password (same as the New Password). The password is case 

sensitive and limited to a maximum of 8 characters. After entering all required fields, click Save Password button 

to save the change. After the Save Successfully message showed up, the user will be prompted with a pop-up 

window to enter the User name and the New Password again for verification.  
 

 
Figure 3-12 – Admin settings Page 

 

 
Figure 3-13 – Entering the User Name and the New Password 

 
The user can define whether the web interface is encrypted (through HTTPS) or not (through HTTP). To carry on 

the selection, click on “Web mode settings” in the menu on the left hand side and choose the desired setting as 
shown in the following figure. 
 

After the choice has been made, click “Save & Apply” A Save Successful message will appear with and the web 
browser will be redirected to the Overview page.     

 

 
Figure 3-14 – Web mode settings 
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3.8  Restart 

 
For some unexpected circumstances, the Protocol Gateway system may stop responding correctly. The user has 

the option to restart the device by clicking the Restart button as shown below. The device’s RUN LED will start 

blinking when the restart process is completed. Then, a message indicating System Restarting status with a 
countdown will show up. After a successful device’s restart, the web browser will be redirected to the Overview 
page.     
 

 
Figure 3-15 – Restart page 
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4 General Description 

4.1 Protocol Gateway Overview 

Atop’s Protocol Gateway “PG” family is a very powerful industrial protocol gateway platform. Based on your 
request, it is bundled with different protocol stacks that can run at the same time in the client/server – 
master/slave mode. 
 
Shown in the below figure a typical application of Atop’s Protocol Gateway 
 

 
Figure 4-1 – Protocol Gateway Application Example 

 
 

Represents the HOST side that is in control of the application issueing read and write commands and 
managing events. It can be a SCADA (Supervision Control and Data acquisition), an IPC, an HMI (Human / 
Machine Interface) etc… In this example, the HOST side works with IEC 61850. This is the Client/Master 
side.  
 
Represents the Device side, connected to the HOST side that receives read/write commands and replies 
to the HOST. In this example, these devices are connected directly to the host because they run IEC 
61850 protocol. This is the Server/Slave side. Only one server/slave per protocol is supported in Atop 
protocol gateways 
 
 
Represents the Device side. In this example these devices run Modbus RTU protocol on RS-485 and they 
will receive read/write commands from a Modbus RTU Host only. This is the Server/Slave side 
 
Represents the Device side for the HOST (SCADA) and the HOST side for the Modbus RTU Devices. 
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The Protocol Gateway’s job is to translate the information from IEC 61850 to Modbus RTU and to let the 
SCADA seamlessly connect to non-IEC-61850 devices. This is the Server/Slave side for SCADA and 
Client/Master side for the Modbus Devices. 

 
Shown in the below figure the general software architecture of the device: 
 

 
Figure 4-2 – Protocol Gateway Architectural overview 

 
The protocol gateway main network settings can only be defined by Web interface.  
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The architecture is made of 3 different parts: 
 

Device Server/Slave interface (that is listening to a Master/Client that is outside a device, a PLC for 
example). This means that Atop’s PG will behave towards an external master as a slave device, in the 
related protocol 
 

Device Client/Master interface (that is actively polling or issueing commands to an external 
Slave/Server) 
 

ADH : the core of the unit that moves, translates and maps the data points/commands/events from the 
client side to the server side and vice-versa 

 
In general, the device allows to map any protocol to any port (serial or Ethernet) based on the limitations and 
constrains from the protocol itself. 
 
eNode designer will allow the user to assign different protocols to different port, define the serial port settings 
and to the protocol-specific parameters.  
 
Inside eNode designer, the user will define for the Master/Client the real IDs of the devices need to get data/send 
commands from and will set for the Slave/Server the virtual addresses to be used from the client for data-point or 
command mapping to the . More information related to eNode designer is available in chapter 5.   
 
The core of the Gateway is the Application Data Hub, where the data/commands/events (if applicable) is stored 
and mapped to the other relevant protocol.  
 

4.2 Device Client/Master 

 
In eNode designer, the user will have to assign a specific protocol to a serial or an Ethernet port. While Serial 
ports allow only one protocol to be assigned to each port, Ethernet ports may have more than one, since 
communication may use different TCP/UDP ports or layer. One Ethernet port can have an IP address only. 
 
The user will have to specify which data points from which Slave/Server IDs should be polled, the data 
type/timeout if applicable and the polling frequency. After this is set and configuration is uploaded to the device, 
Atop’s Protocol Gateway will start to automatically poll the slaves based on that configuration.  
The received data will be stored into the ADH internal database and then automatically synced with the 
server/slave protocol internal database.  
 
Commands sent from the Device Server/Slave side instead, once properly mapped in eNode designer will be 
executed only upon request and won’t be routinely executed. The user will be able to customize timeout settings 
in eNode designer. 
 
In general,the gateway is as a client/master role and needs to read/write data from/to other devices which are as 
server/slave role, so: 
                Step1. Assign a device with specific protocol to an interface (serial / Ethernet). 
                Step2. Do the configuration for talking with the device including communication related parameters,  

               protocol related parameters and data points for read/write. 
                Step3. Goto the Step1 if there are more devices connected. 
 

4.3 Device Server/Slave 

 
As client/master, in eNode designer, the user will have to assign a device to a serial or an Ethernet port by 
designating a specific protocol first. While Serial ports allow only one protocol to be assigned to each port, 

1 

2 
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Ethernet ports may have more than one, since communication may use different TCP/UDP ports or layer. One 
Ethernet port can have an IP address only. 
 
The user will have to specify which data points/commands should be made available for the external client (e.g. a 
PLC) and may map such data points/commands with another Client/Master data point/command point.  
 
Some protocols support unsolicited events to be triggered by the device. If this function is necessary, the user 
may set the threshold so that upon going over it an unsolicited event will automatically be triggered. 
 
Aside unsolicited events, Server/Slave function is always in listening mode, waiting for read/write commands to 
be issued from the master. When a read command is received, the most updated data point available in the 
database will be returned with the related timestamp if defined in the server protocol specifications. When a write 
command is received, this will be relayed to the related Client/Master module and executed. If expected by the 
protocol spec, a confirmation message will be returned 
 
In case of communication problems between Client/Master and the slave, exceptions will be returned.  
 
In general, the gateway as a Server/Slave role needs to define virtual data points for the Hosts to read/write. 
                Step1. Create a virtual Sever/Slave with specific protocol to an interface (serial / Ethernet). 
                Step2. Do the configuration for this virtual Sever/Slave including communication related parameters,  
               protocol related parameters and data points for read/write. 
                Step3. Go to Step1 if there are more virtual Severs/Slaves that the gateway plays. 
 

4.4 Example – general settings 

 
An example of a DNP3.0 Ethernet Server to Modbus Serial Master Gateway follows. Assuming the following 
configuration 
 

 Protocol Gateway – Server/Slave settings: 

 Protocol: DNP3.0 Server (from eNode designer) 

 Interface: LAN 1 

 IP (from WebUI): 10.0.50.1 

 TCP Port: 20000 (from eNode designer) 

 Connected to: DNP3.0 Client PLC 
 

 Protocol Gateway – Client/Master 

 Protocol: Modbus RTU (from eNode designer) 

 Interface: RS-485, port 1 

 Baud rate: 19,200 bps 

 Data bits: 8 

 Stop bits: 1 

 Parity: none 

 Connected to: Modbus RTU sensor 

 Modbus RTU device ID: 157 

 Client/Master Polling configuration (eNode designer): 

 Device to be polled : Modbus ID 157 

 Function: 03 read status registers 

 Starting address: 10 

 Quantity: 2 

 Polling time: 200 ms 

 Timeout: 100 ms 
 

 Server/Slave Data points (eNode designer) 

 Number of points: 10 
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 Data Type: word 
 

 Data points mapping (eNode designer) 

 Modbus 0-1 >> DNP3.0 5-4 

 

4.5 Example - Polling process 

 
 
 

 
Figure 4-3 – Protocol Gateway Polling Process 

 
The configuration file from eNode designer is successfully uploaded to Atop’s Protocol Gateway 
 
Following the configuration, Serial port 1 polls Modbus ID# 157, function 03, address 10 quantity 2. 
Serial port works with 19,200 bps, 8 data bits, 1 stop bit, no parity 
 
Modbus device returns the data read for the 2 registers, the data is “FF” hexadecimal for register 0 and 
“06” hexadecimal for register 1 
 
The data is stored into Modbus Client/Master database  
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The data is synced with the ADH database. The value “FF” hexadecimal is mapped automatically to 
DNP3.0 address 5 and the value “06” hexadecimal is mapped automatically to address 4 with the 
related timestamp.  
 
The data is synced with the DNP3.0 Server/Slave database. The process from 2~6 is repeated 
automatically every 200 ms according to the configuration in eNode designer. In case of a 
communication error, an event may be issued (depending on the protocol) 
 
The DNP3.0 client (e.g. a PLC) issues a read command to the DNP3.0 gateway with IP 10.0.50.1 on 
TCP port 20000, asking for addresses 4~5 
 
Atop’s Gateway DNP3.0 server module returns to the DNP3.0 client “06” hexadecimal and “FF” 
hexadecimal (as respectively addresses 4 and 5 
 
DNP3.0 client receives the data. 
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4.6 Example: Command process 

 

 
Figure 4-4 – Protocol Gateway Command Process 

 
 

The DNP3.0 client issues a write command/ Select-Before-Operate command to Atop’s protocol 
gateway (IP 10.0.50.1; port 20000; connected to power 1) 
 
The DNP3.0 server module on Atop’s protocol gateway receives the command and places it into the 
server command database 
 
DNP3.0 Server command database is Synced with ADH database, where the command address/ write 
information is mapped to Modbus ID/ write command. 
 
ADH database syncs with Modbus Client/Master. 
 
Modbus Client/Master issues a Modbus command to the designated ID (157) with the Serial port 
parameters set in eNode designer (Baud rate: 19,200 bps, 8 data bits, 1 stop bit, no parity) and waits 
for Modbus device response within the timeout set.  
 
The Modbus Slave responds to the command. 
 
Modbus Client/Master receives the response and syncs with the Modbus module database. 
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The ADH database is synced and the information mapped back to DNP3.0 according to the settings 
made in eNode designer. 
 
DNP3.0 server module syncs the information from ADH, and issues the response to the DNP3.0 client. 
 
DNP3.0 client receives receives the command execution confirmation or the exception. 
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4.7 eNode Designer Overview 

The overall goal of eNode Designer is to configure target platforms, set device properties and ADH data point 
mapping. To do this, a project file representing the system should be created. This will include devices and the 
ADH applications running on them. The configuration is completely dependent on the “eNode Module” which 
represents that device or application – but may include things such as changing the communication port settings 
and defining where data point information enters and leaves the eNode Designer system.  
 
Each target platform is represented by a “Device” eNode Module. This device may specify what communication 
ports it has, e.g. two Ethernet ports ETH1 and ETH2, and a serial port COM1.  
 
Each ADH applications is represented by an “ADH Application” eNode Module. The module can be added to 
devices at an appropriate location. For example, a Modbus application can be linked to the COM1 port, while a 
PLC application can be added directly to the device itself (i.e. not bound to a communication port). 
 
Each eNode module can add data points to eNode Designer that  can then be mapped amongst the system. 

 

Figure 4-5 - eNode Designer overview. 

eNode Designer also contains diagnostics capability – this includes reading the current values and health status 
of data points in the system and reporting back to the user. 
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5 eNode designer User Guide 

5.1 Installation 

The eNode Designer is being shipped with installer software for easy installation on a Windows™ based personal 
computer.  
 
Minimum system requirements are: 
 

 Windows 7 operating system or higher 

 Java version 8 or higher installed on the computer 

 One mouse device or mouse pad installed 

 At least 1 GByte free hard disk space 

 At least 500 Mbyte of free RAM 

 Ethernet port for sending configuration files. 
 
It is recommend to use at least a 17 Inch monitor when installing on a desktop type computer. 
 
Installing the eNode Designer is easy. All files are self-extracting.  
 

 
 

Figure 5-1 - eNode Designer Setup Installer 

 Run the eNodeDesignerSetup.exe program to install the eNode Designer. 
 

The User Account Control window may appear asking to allow the application to make changes to the current 
computer settings. Click “Yes” to continue. Then the following window will appear. 
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 Click Install to start installation       
 
 
 
 
 
 
 
 
 
 

Click Close to complete installation. The program 
will show up in the Program menu and can be 
started from there 

 
 
 

5.2 Main Screen 

 

 

Figure 5-3 - eNode Designer main screen. 

 
Throughout this document, all the screens and menus show what an eNode Designer user sees. There may be 
differences on the exact appearance, but the principals are the same. The three major parts of the eNode 
Designer screen are described below. 
 

Menu Bar – contains various options available to the user, such as saving and loading projects. 
 

Project Tree – shows the contents of the current project represented as a tree. 
 

Main Display Area – displays according to what is selected in the project tree. 
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5.3 Login 

In order to start using eNode Designer, you will first need to login. Type in your username and password, and 
press enter (or click Login) to login. If your details are correct you will be brought in to the main eNode Designer 
screen. 
 
 
When eNode Designer is run for the first time, it will have one user: 
 

Username: admin 

Password: admin 
 
It belongs to the “Administrator” user group, which by default has full permissions. After logging in for the first 
time it is recommended to change the username and password. See section 5.4 for details.  
 

 

Figure 5-4 - Splash screen and login window. 
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5.4 User Administration 

Each “User” login belongs to a “User Group” which defines the permissions of all users in that group.  
 

 

Figure 5-5 - User administration principal. 

Adding, editing and removing users and user groups is achieved through the user administration menu.  
 

 

 

Figure 5-6 - Access user administration. 

 

5.4.1 Creating, modifying and removing users. 

To define users, use the “Users” tab of the user administration window. The three buttons are explained below: 

Add This function adds a new user. The user will be prompted for the username, password and the 
user group the user will belong to.  

Edit This function modifies the username and password of an existing user. The user should select 
the user in the table first. 

Remove This function removes the selected user from the system. The user should select the user in the 
table first. 

 
 
For example, to add the user “Alice” with user group “Engineer”, you can use the add button, set the information 
and click OK. 
 

Users:  

User groups: 

Alice Simon Tom 

Engineer 

Permissions 

Technician 

Permissions 
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Figure 5-7 - Adding a new user. 

This will add a new user who can login to eNode Designer with username “Alice” and the specified password.  
You can change the user group of a user by using the drop-down option in the user administration window. 
 

 

Figure 5-8 - Changing a user's user group. 

5.4.2 Defining User Groups 

To add a user group move to the user groups tab and use the “Add” button.

 
 

Figure 5-9 - Adding a user group. 
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You will be prompted to type a name for the user group, and then it will be added to the list. Users can then be 
added for that user group. All users with that user group will have the same permissions. 
 

 

 

Figure 5-10 - User group added. 

Other actions such as renaming the group and changing the permissions can be accessed by using the 
associated buttons after selecting which group you want to change.  

Add  Adds a new user group. 

Rename Renames the selected user group. 

Remove Removes the selected user group from the system. 
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5.5 Importing eNode Modules 

 
eNode Designer requires “eNode Modules” before it is particularly useful. Some eNode Modules may come 
bundled with the installation, but otherwise they need to be imported to eNode’s module library. Also if a new 
version of a module is released, it can be imported to replace the old version. This is achieved through the Module 
Management window, which can be reached from the Tools menu. 
 

 

Figure 5-11 - Getting to the module management window. 

This is an example that demonstrates importing a new module named the “New”. 
 
 
 
 
 
 
 

Select Module Management under Tools in eNode Designer 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select Import Module and navigate to the subdirectory in which the New module is  
 stored. 
 

 Select the New.jar 
 

 Click Open to import the New JAR  
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Click OK to finish 

 

5.6 Creating a project 

By default, starting eNode Designer will load the last open project. The first time it runs it will start with a new 
project. The next time, it will open the last edited project.  
 
Creating, changing and removing the contents of a project is achieved through the right-click menu on the project 
tree. The right click menus are context sensitive – right clicking the project node will have different options to 
when right clicking a device or ADH application. 
 

5.6.1 Project Information 

 

Figure 5-13 - Project Information 

The project information pane is shown when the project root is selected in the project tree. Here the user can 
enter details about the project including a project name, description, author(s) and version history.  
 
 

5.6.2 Adding a Device (a.k.a. Target Platform or CFE) 

Once modules are known to eNode Designer (i.e. visible in the Module Management window, see section 5.5) 
they can be added to the project. Since ADH Applications have to have a platform to run on, the target platform 
must be added to the project first. This can be achieved through the right-click menu on the project tree root. 
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Figure 5-14 - Adding a device to the project.  

 

Figure 5-15 - Device added to project. 

In this example, we have added a device with two Ethernet ports and four serial ports. More than one Device can 
be added to the project using the same process.  
 

5.6.3 Editing Ethernet Port Properties 

While the device-specific IP addresses can be set via Web interface (Refer to Chapter Network Configuration ) or 
via Device View (Refer to Chapter Configuration of Network Parameters through Device View ) eNode designer 
requires the user to specify the device’s properties in the project file too. 
This is necessary in order to identify the device to which the configuration should be uploaded to uniquely among 
the network. 
 
In this example, the ETH1 port is set to IP address 192.168.1.115, Subnet mask to 255.255.255.0 and Default 
Gateway to 192.168.1.254. 
 

 
 

Figure 5-16 – Network properties modified. 

Device added 
to project 
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5.6.4 Editing Communication Port Properties 

It depends on the device module, but generally you can edit the properties of the communication ports by clicking 
the appropriate item in the project tree.  
 

 

Figure 5-17 - Editing communication port settings example. 

 

5.6.5 Adding an ADH Application to a Communication Port 

ADH Applications can be added to the appropriate locations on the device via the right-click menus. Some eNode 
Designer Modules must be added on communication ports, while others may run on the device directly.  
 
For example, an IEC 60870-5-101 application can run on serial ports only, so a IEC 60870-5-101 ADH Application 
could be added to the COM1, COM2, COM3, COM4 only. This IEC 60870-5-101 option will not show up for the 
Ethernet port since this protocol cannot run on Ethernet. 
 

 

Figure 5-18 - Add ADH Application to communication port example. 

When a Client/Server choice is possible for ADH Applications, such as IEC 60870-5-101, you will see a window 
like Figure 5-19. 
 

 

Figure 5-19 - Choosing client or server. 

Use the dropdown menu to choose the client or server option, then click OK. Atop protocol gateway supports one 
server application per protocol per device.  

1 
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Figure 5-20 - ADH Application added to project. 

Here the application has been added to the project, as a client. By default new modules will be selected, and so 
their pane will be shown in the central area. How to configure an eNode Module is described in that module’s user 
manual.  
 
 

  

Application has 
been added 
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5.7 Data Points 

 
Because creating data points is handled by the eNode Modules themselves, exactly how it looks is up to the 
respective module, so the screens cannot be described here. However, the general process is client applications 
produce data points, which are raised up to eNode Designer. These points can then be mapped to server 
applications. Most server applications will have a way to add references, which will bring up the following window. 
 

 

Figure 5-21 - Adding data point references. 

 

Point display area – this shows the existing points in the system which can be mapped to the eNode 
Module which generated this window. Note that some modules may be restricted in what data types they 

may accept. For example, some may not have a 32-bit floating-point number type. So 32-bit floats will not show in 
the list. 
 

Filter by Tree Selection – the points display area shows only points beneath the selected tree node. 
 

Map Selection – click the checkboxes to add a reference to that data point. 
 

Click OK – to add the new reference(s). 
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5.8 Viewing the Database of Data Points 

 

To view the existing data points in the system use the “Data Point View” window accessed in the View menu. 
 

 

Figure 5-22 - Accessing the data points view. 

 

Figure 5-23 - Data point view window. 

The data point view window is separated into many sections described below:  
 

ADH Group – Select which ADH group to look at. Each ADH group is a network group in which only devices 
in that network can communicate. That is, a device in ADH Group 1 cannot communicate with a device in 

ADH Group 2. Most projects will only have one network group – in which all devices can communicate with each 
other. 
 

Project Tree – The project tree display. The main point list will only show data points beneath the selected 
tree node. 

Data Points – shows all the data points in the system subject to the filters of (2) and (5). 

 
Mapped Data Points – shows where the selected data point in (3) is mapped. 
 

Filters – Only show data points that match the given filters. 
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Legend – Describes the colour scheme of the tables. 
 

Show / Hide Filters – Button to show and hide the right pane containing the filters and legend. 
 

 

5.9 Generate and Send Configuration Files 

 
When all data points and mapping have been completed, you can generate and send the project configuration 
files to the target platforms.  
 

5.9.1 Setting up the FTP Details 

Sending the files works by FTP (File Transfer Protocol), so first the FTP settings must be set in eNode Designer. 
To do this, right click the device in the project tree and select “Device Settings”. 
 

 

Figure 5-24 - Access device settings to set FTP settings. 

This will bring up a new window in which you can set the FTP settings. This includes settings the Ethernet 
channel used for FTP, the username, password and port. On some devices, the configuration directory is also 
configurable. 
 

 
Figure 5-25 - Device settings window. 
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The IP address is extracted from the Ethernet’s properties configured in the project. If there are multiple Ethernet 
ports on the device, use the dropdown box to select which of the device’s Ethernet ports is to be connected to the 
PC running eNode Designer. 
 

Note: If the device’s Ethernet properties are going to be configured by the project, place the desired IP addresses 
in the project, and then use the FTP IP source as “Custom” and type in the current IP address of the device. This 
may be necessary when receiving a product from a manufacturer in which the IP address is pre-set and needs to 
be changed.  
 

5.9.2 Send the Configuration 

Once all the FTP settings of devices have been set, you can send the configuration files to them. Because sending 
configuration files is a significant event, you will first be prompted to add a new version to the version history.  
 
The configuration files for all the devices and applications will be generated and stored on the local hard drive 
ready to be sent to the device. When completed, the send configuration files window will show.  
 

 

Figure 5-26 - Send configuration files window. 

There are descriptions of the buttons and fields below. 
 

Open Device Settings – Can be used to change FTP settings as in  

Figure 5-25. 
 

Open Configuration Directory – Opens the local directory in which the configuration files were generated.  
 

Send to Device – Sends the configuration files to the individual device by FTP. 
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Reboot Device – Sends a reboot command to the diagnostic application currently running on the device.  
 

Device Name – Textual representation of the full path to the device in the project tree. 
 

Status – The status of sending the files. 
 

Progress Indication – Shows the progress of the file transfer 
 

Send All – Sends the configuration files to all devices. 
 

Cancel Sending – Cancels sending the configuration files. 
 

 
 
 
After sending the files has completed, a dialog will show asking the user if they want to reboot the devices. 
 

 

Figure 5-27 - Asked to reboot after sending configuration files. 

The applications on the target platforms will require a restart to load the new configuration files. 
 

5.10 Diagnostics 

 
Diagnostics is used to examine the the execution of the ADH on target platforms while they are running. 
 
Diagnostics features: 

 View live values of all data points on each target platform. 
 
Features that may be implemented in future: 

 View communication port traffic – including transmitted and received data. 

 Value substitution 
 
The diagnostic information is transferred to eNode Designer by the Diagnostic ADH Application running on the 
device. As such, diagnostics is started per device, not per application. The diagnostic application is able to view the 
current data point values on the device. 
 

The diagnostics window is the same as the Data Point View window as in Section 0:   
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Viewing the Database of Data Points. Access the window by the menu option View => View Data Points. 
 
To start diagnostics on a device, right click the device (or any tree ancestor) and click “Start Diagnostics”. 
 

 

Figure 5-28 - Starting diagnostics. 

Starting diagnostics will add a column to the table named “Live Value”, and automatically change the southern 
tab to the Diagnostics Log. 
 

 

Figure 5-29 - Diagnostics screen explained. 

Each major section is described below. 

Diagnostic Status – the device tree node’s colour indicates its diagnostic status. Hovering over the device 
will give more information.  
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Live Value – shows the current value of the data point on the device. If the data point’s quality status is not 
“OK”, it will show with a “###” to indicate this. 

 

Diagnostic Log – a log showing the data point update messages as they come in. This list is filtered by the 
selection in the project tree. 

 

Table Filter – Filters the log by the specified values. The filter works with wildcards and the like by using 
“regular expressions” (regex). For example typing in “DI” in the “Tag” filter would filter the log to only contain 

points with a Tag containing “DI”. 
 

5.11 Loading Projects from a Device 

 
In eNode Designer, every time configuration files are sent, a copy of the current project is also sent to the device. 
The project is also placed in a “Project History” directory on the device.  
 
eNode Designer can recover any project that has been sent to the device, provided it hasn’t been deleted. There 
are two ways to recover a project.  
 

1. Right-click a device in the project and select “Browse Project History”. 

 

Figure 5-30 - Browse project history of a device in the project. 

2. Use the option from the file menu. Using this option only the IP address and FTP details of the device are 
required, so can be accessed from an empty project. 
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Figure 5-31 – Browse project history of a device unknown to the project. 

Using either option, a “Browse Project History” window will open. This will connect to the specified FTP details (or 
the FTP details registered with the device in the project), and show the project history window. 
 

 

Figure 5-32 - Browse project history. 

If the FTP connection and login are successful, the project history will be displayed in a list.  
 

This area shows a list of projects which have been sent to the device. The currently active project is 
highlighted in green. 

 
Use this button to delete projects from history. A confirmation message will appear. The currently active 
project cannot be deleted. 

 
Retrieves the selected project from the device and loads it in eNode Designer.  

 
  

1 

3 

2 
 

Enter details 

1 

2 
3 

1 

2 

3 



eNode Designer User Manual eNode designer User 
Guide 

 

Page | 51 
 

5.12 Organising a Project 

 
The eNode Designer tool allows managing a single product or a number of products to be configured and 
managed in one project.  
 
►Tip: It is always a good idea to use “Groups” in the project tree to define the location of a product if several units are being 

managed in one project file. 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
2 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
Groups can be added to the project root and inside other groups. For a detailed explanation about the options 

when adding groups, see Section 5.13.2: Creating a Group with a Style Sheet. 
 

  

1 

“Add Group” as an option 3 

“Add Device” PG5901 
For Location1 and 
PG5901E for Location2 

 

Figure 5-33 – Project tree organisation. 
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5.13 Advanced – Tree Group Style Sheets 

 
Any project in eNode Designer can use logical groupings in the project tree to organise the project. For 
convenience, each of logical groups in the tree can contain customized information. There is an example in Figure 
5-34. 

 

Figure 5-34 - Project tree group example. 

 
In addition, exactly what labels and fields are available are customisable. This is achieved through “Style Sheets”. 
Each style sheet describes a set of fields, including their field types and labels. Every group is bound to a style 
sheet, and each style sheet can be used by many groups. 

 

Figure 5-35 - Style sheet interaction with groups. 

 
 

5.13.1 Editing the Style Sheets 

 
The definition of a style sheet can be changed, and new style sheets can be added and removed. This is 

accessible through the Tools menu as shown below. 
 
 
 
 

Style sheet: 

Group A Group B Group C Tree group: 

Style X 

Fields 
Definition 

Style Y 

Fields 
Definition 
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Figure 5-36 - Accessing the style sheets. 

This will open the window to edit style sheets. 
 

 

Figure 5-37 - Edit style sheets window. 

There are three sections to the window: 
 

Style sheet selection – Select which style sheet to investigate and edit. 
 

Fields – The fields of the selected style sheet. This includes a type, label and default value. 
 

Preview – The preview window of the style sheet, with default values. Editing the values in the preview will 
set the default values of the field. 

 
 

The fields can be edited in the field table in area (2). The labels describe the static values which will appear 
before the text. The default value is the values which will appear in a new tree group when it is added to the 
project. 
 
The field types available are: 

 Title (Constant) – A title that is the same for all tree groups with this style. 
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 Title (Editable) – A title area in which each tree group can have its own value. 

 Single line input – A single line input like “Location 1” in the above example. 

 Multi line input – A multiple line input which takes up remaining space, as in “More Information” in the 
above example. 

 
 
Examples: 
You can change the labels and default values by editing the fields table. You can also type in the preview screen 
to modify the default value. 
 

 

Figure 5-38 - Style sheet example one. 

 
If we change the description to be a multi-line input, the remaining space will be evenly taken by both multi-line 
inputs.  
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Figure 5-39 - Style sheet example two. 

 

5.13.2 Creating a Group with a Style Sheet 

When tree groups are added to the project, they need to bind to a style sheet. Select “Add Group” from the project 
tree menu. Groups can be added to the root project node and within other groups. 
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Figure 5-40 - Adding a group to the project. 

Select “Add Group” from the right-click menu. 
 
Enter the new name for the group. This is the name which will appear in the tree. It can be renamed later. 
 
Select a style sheet to use. This shows a drop-down menu of all style sheets in the project. 
 
A preview of the selected style sheet. 
 
A convenience button to access the style sheet definitions.  
 

Click OK when done. 
 

A new group will be added to the project with the selected style sheet and default value. 
 

 
 

Figure 5-41 - Group with style sheet has been added. 
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5.13.3 Changing and Existing Group’s Style Sheet 

 

Figure 5-42 - Change the style sheet of existing group. 

Select the group in the tree. 
 
In the display pane of the group, there is a button. Clicking this will open a new window. 
 
Select a new style sheet to use. This shows a drop-down menu of all style sheets in the project. 
 
(Optional) Copies (resets) the values of the tree group to the defaults of the style sheet.  
 
Click OK when done. 
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5.14 Report Generation 

 
The following reports can be generated by eNode Designer. 

 Data point report (with and without mapping). Access this by the Tools menu. 
 

Generated reports are in the form of Microsoft Excel™ spreadsheets. They are based on editable user-editable 

Excel templates. To view and edit the template, use the View => View Report Templates Directory option in the 
eNode Designer menu bar.  
 
 

 

Figure 5-43 - Open report templates directory. 

Clicking this will open the reports template directory in your operating system’s file explorer. 
 
Open the report template 
 

 

5.14.1 Data Point Report Template 

The data point report template generates a report on the data points beneath the specified location in the project 
tree. The default template looks like this. 
 

 

Figure 5-44 - Data point report template. 

 
All cell text, widths and heights are editable by the user. The generated report will start with a copy of the 

template and then just replace the keywords.  
 

A cell must contain the exact keyword in order for it to be replaced. The keywords are as follows: 

 $DATE – The date the report is generated. 

 $LOCATION – The tree node location which is being reported on. 

 $FILE – The filename of the eNode Designer project for which the report is generated. 

 $DATAPOINTS – Data point information will replace this row and every row beneath this row, up to the 
number of rows required to generate the full report. 
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Replacing the values of data points does not examine the title of the columns. The columns output will always be in 
the same order. 
 

5.15 Settings 

 
The settings available in eNode Designer are available by using the Settings menu. 
 

 
 

 

Figure 5-45 - Settings window. 

Here the user’s language and preferences can be set. The settings of eNode Designer can also be set in this 
window. Setting the language for eNode Designer will set it for all users that have “Use platform settings” set for 
their locale. An individual user can override the eNode Designer’s language by specifying it as a particular 
language. 
 
The locations of some directories of eNode Designer can also be set and opened in this window. 
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6 eNode designer Reference Guide 

6.1 Menu Bar Options 

6.1.1 File 

Function Description 

New Project  Creates a new empty project. 

Save Project Saves the current project. 

Save Project As… Saves the current project as a new file. 

Save Project Copy… Copies current project to a new file. Editing continues on the original file 

Open Project Loads an eNode Designer project. 

Open Recent Shows recent project files for faster processing. 

Generate and Send 
Configuration Files 

Generates and sends the target platform settings and ADH application configuration files 
to the target platforms. See section Generate and Send Configuration Files 5.9 for details. 

Load Project From 
Device 

Loads the eNode Designer project stored on a target device. See section 5.11 for details. 

Logout Logs out of the current user. 

Exit Exits eNode Designer. 

 

 

6.1.2 Edit 

Function Description 

Copy  Copies the selected tree node (to be pasted). 

Cut Cuts the selected tree node (to be pasted). 

Paste Pastes the copied or cut tree node beneath the currently selected tree node. 

Delete Deletes the currently selected tree node. 

  

 

6.1.3 View 

Function Description 

View Data Point  Views the current data points in the system. Allows to access diagnostics. 

View Logging Directory Opens the directory containing log files. 

View Reports Directory Opens the directory containing reports, such as data point reports. 

View Report Templates Directory Opens the directory containing report templates 

View Configuration Generation 
Directory 

Opens the directory containing the files produced when sending 
configuration files to target platforms 

Communication Overview Opens a graphical display showing which devices are configured to 
communicating in the current project. 

 

  . 

 . 
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6.1.4 Tools 

Function Description 

Module Management
  

Opens the module management window, responsible for importing, enabling and 
disabling eNode Modules. 

Edit Style Sheets Allows the user to define the tree group style sheets. 

Generate Data Point 
Report with Mapping 

Generates a data point report with mapping, using the report template. 

Generate Data Point 
Report without Mapping 

Generates a data point report without mapping, using the report template. 

 
 

6.1.5 Settings 

Function Description 

User Preferences Opens the settings for the eNode Designer Platform and the current user. 

User Administration Opens the user administration window, allowing editing users and user groups. 

 
 

6.1.6 Help 

About  Shows information about the eNode Designer version and copyright notice. 

 

6.2 Tree Menu Options 

Menu Item Description Availability 
Add Group Adds a new group to the project Root, group 

Add Device Adds a new device to the project Root, group 

Add ADH 
Application 

Adds a new ADH Application to the project Device, valid 
communication port 

Copy Copies the tree node (for pasting) All but 
communication port 

Cut Cuts the tree node (for pasting) All but 
communication port 

Paste Pastes the copied or cut tree node All 

Rename Rename the tree node All 

Delete Removes the tree node (and descendants) from the project. All but 
communication port 

Device Settings Opens the device settings window. Includes options to set ADH 
Ethernet channel and FTP settings. 

Device 

Table 6-1 - Tree context menu options. 
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